Telosys 1.0.2 Starter Kit

How to create a new Telosys project in
Eclipse 3.2 WTP
and
how to generate the Data Access Layer
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1 — Install the “TelosysTools plug-in” in Eclipse

Stop Eclipse

Downloadtelosys-tools-plugin_X.X.X.zipfrom the Telosys web site
http://telosys.ow2.org~> Download

Unzip file telosys-tools-plugin_X.X.X.zipin the Eclipse « plugins » directory
Restart Eclipse
Check the “Plugin details” : “Help®> “About Eclipse”> “Plug-in details”

The Telosys Tools plug-in must be in the list.

2 — Define the JRE

Window = Preferences ...

| & Preferences |:i@

| type fiter text | Installed IREs Sl

'_+ eneral 21| padd, remove or edit JRE definitions.
[+ Ank B default, the checked JRE is added to the build path of newly created Java projects,

-Dakg Installed JREs:
[+ Help i ]
- InstallUpdate | Mame Location Type add...
[+ Internet B jre6 C:\Program FilesiJavaljreé  Standard Wi
= Java
. [#- Appearance
- [# Build Path
- [#-Code Style
- [#- Compiler |
- [®- Debug |
. [# Editor |
IR stalled JRES RS

o Execution Ens

- Uit

. Properties Files Er
[#- Plug-in Development
[#- Run/Debug v
| >

(7 I (o] 4 ] [ Cancel

Select « Add » button and browse JRE home directory
Choose a full Java SDK, because a Java compitegisred ( to compile the JSP )

Telosys supports all the Java versions from 1.4
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JRE tvpe:
JRE name:
JRE home direckory:

Default M Arguments: |

|Stan|:|ar|:| W

vl

| JavaS0za

| [nhJaval Javasozs

| LE.I’DWSE. T

JRE svystem libraries:

R R B R T R = R

=
N
=
=
—
=
=
A

fm L:h JavalJavasozajret bk, jar

fm Ciiy Java' Javas0zahjreilibljsse. jar

f@ Ci:y Javal Javas0zajreilibljce. jar

fm Ly JavalJavasnzdtjreilib charsets. jar
C: Javal Javasozajretliblextidnsns, jar

C:h JavalJavasozajrel iblext localedata, jar

C:h JavalJavasozdjretliblextlsunjce_provider . jar
C:h JavalJavasozdijrelliblextsunpkes 11, jar

[ Add External JARs. ..

Remowve

Up

Daovan

Javadoc Locakion. ..

Source Atkachment. ..

(0] 4 ] [ Cancel

Select the JRE just added ( other unused JREeaentoved )

& Preferences |:|E]

| bype Filker bext |

[0 B B B )

Genetal A
ant i
Data

Help

Install/Update

Inkernet

Java

Appearance

Build Path

Code Skyle

Cormpiler

Debug

Editar

Installed JREs

E:xecution Ens
. ~
A Imik —

| ?

N e R = T R

Installed IREs

add, remove or edit JRE definitions,

B default, the checked JRE is added to the build path of newly created Java projects.,

Installed JREs:

oo

Marne
= Javasnz

Location
O:hJavah Javasozs

Type
Standard Wh

add. ..
Edit. ..
COpY...

Remaove

04

l l Cancel

Select « OK » button
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3 — Define the Tomcat server

Select Window> Preferences ...

& Preferences

| byvpe Filker bext

General

Ank

[raka

Help
InstalfUpdate
Inkernet

EH-H

Java

Run)Debug
Server
Audio

& & & B - -

Launching
Team
Yalidakion
Wb and ML
=
<

O LL—b Ceensimmm

|

Plug-in Development

Installed Runtime

Installed Server Runtime Environments

add, remaove, or edit installed server runtime definitions,

Installed server runtimes:

MName Tvpe

| .8

Search...

|

|

k.

l [ Cancel

Select « Add » button
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& New Server Runtime @

MNew Server Runtime

Define a new installed server runtime environment

Runtimes are used at build time ko compile projects,

Select the bype af runkime that wou wank to define:
Don't see vour server listed? Click here
== Apache ~
E Apache Tomcat v3.2
B Apache Tomecat 4.0
@ Apache Tomcat w4, 1
a fpache Tomcat ws.0 B
E Apache Tomcat v5.5
[= BE& Systems

(Ll (70 Drmmim

|

Wiew By | Yendor w
Description: Apache Tomcat v5.0 supports J2EE 1.2, 1.3, and 1.4 Web modules,

() = Back [ Mexk = ” Eirish H Zancel

Select « Next » button and:

- browse for Tomcat installation directory
- select java version

& New Server Runtime [E

Tomcat Server

Specify the installation directorsy

Marmne:

| Apache Tomcat v5,0 |

Tomcat installation direckory:

| e Tomcat Tomcat-5,0,28 | [ Browse, ., ]

v| [lnstalleu:l JREs... ]

':?:' Mexk = Einish ] [ Cancel

Select « Finish » button
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4 — Create a standard Dynamic Web Project

File > New (Alt+Shift+N) > Project ...

Web-> Dynamic Web Project (with Tomcat 5.0)

& New Project x|

Select a wizard —
Create a Dynamic Web project

Wizards:
I type filter text
[E!P Eclipse Modeling Framework j
- EIB
B 12EE
B Java
B Plug-in Development
=2 Web
g1 Dynamic Web Project
L.;5% Static Web Project
-2 Bxamples -
@

(7 = Back I Mext = I Firigh Cancel
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& New Dynamic Web Project

Dynamic Web Project

Create a standalone Chynamic Web project or add it to a new or existing Enterprise
Application,

Project name: | TelosysToolsExample

Project contents:
IJse default

Target Runtime

| LA TelosysToolslwksTelosesTools\ Telosys TonlsExample | Bromsse

| fpache Tomcak «5.0 V| [Ne_w... ]
Configurations
| <cuskam = it |

Hirt: Get started quickly by selecting one of the pre-defined project configurations.

EAR Membership

Add project toan EAR

E&R Project Name; [ EAR

New.. .

L'E) [ < Back ][ Mexk = ” Einish ][ Cancel ]

Select « Next » button
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£ New Dynamic Web Project @

Project Facets
Adds support For wriking applications using lava programming language.
onfigurations; |=:|:ust|:|m:=- W | [ Save ] Delete
Projeck Facet Version
[¥]/59 Drvnamic Web Module 24
[ 5.0..
[ 5 webDoclet (#Daclet) 1.2.3 ...
<< Show Bunkimes
'i?:' [ < Back ][ Mext = ] [ Einish ] [ Cancel

Select « Next » button

#= New Dynamic Web Project @

Web Module

Configure web module settings,

Context Root:

| TelosysToolsExample |

Contenk Direckary:

| WiehContent |

Java Source Directory:

| SrC |

Mexk = Eirish ] [ Cancel

Select « Finish » button
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5 — Test projet with Tomcat

Create the « test.jsp » file WebContent directory

Right click onwebContent directory=> New -> JSP

£ New JavaServer Page @

JavaServer Page
Create a new Javaderver Page. Q

Enter or select the parent folder:

| TelosysToalsExampleWebConkent

o
1=F Servers
'&J TelosysToalsEx
=k, < TelosysToolsExample
[== .settings
= build
= src
[= wWebContent

File name: | kest.jsp

7 [ Mext = H Einish H Cancel

Select « Finish » button

Insert “hello” in the <body> tag of the JSP file
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B testjsp X = 0O

<%[ page language="ijava™ contentType="text/html;: charset=I30-{
pageEncoding="I30-8559-1"%>
< !DOCTYPE html PUBLIC "-//W3C//DTD HTML 4.01 Transitional//EN'
<html=>
<head:>
<meta http-egquiv="Content-Type™ content="text/html; charset=I!
<titlexInsert title here</titlex
</ heads>
<hody>
hellao
</body>
</ html>

Right click ontest.jspfile &> Run As—> Run on Server

& Run On Server

Define a New Server

hoose the bype of server to create

How do wou want to select the server?

iz SarvEr
2 AISUINE] Sy

(%) Manually define a new server

Server's host name: | localhost w

Select the server bype;
Don't see vour server listed? Click here
=7 Apache -,

=

~ |4 Tomcak «3.2 Server

El

L

Tormcak w4.0 Server

Taomcak w4.1 Server

Tomcak ¥5.0 Server
Tomcak 5.5 Server

+-[= BEA Systems

[#-{=> TBM =

F-[= IBoss

| (= Objectiteh *

] [ )

Wig Bys i'u'enu:h:ur v |

Description: Publishes and runs JZEE Web projects and server configurations to a local Tomcak server,

Server runtime: i.ﬁ.pache Tomcat v5.0 . | Elnstalled Rurkimes. .. |

[ ]5et server as project defaulk (do not ask again)

()
al

= Back: Mexk = H Einish ][ Cancel ]

Select « Next » button
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Make sure that your project is in the « Configupediects » part

& Run On Server @

Add and Remove Projects

Modify the projects that are configured on the server @
- —

Maove projects ko the right o configure them on the server
Available projects:

Configured projects:
l_qg TelosysToolsExample
add =
< Remove
fdd All ==
<< Remove ol

@ | <Back [ mest> || Fnsh || cancel
Select « Finish » button
Verify the good execution of your JSP file
test.jsp = O
#= m |http:,l',l'Iu:ucthcusI::EIIZIE!EI,I'TEIDS':.-'STDDIsExampIe,l'test.jsp v| =3
hello
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6 — Import the Telosys Starter Kit in the project

Stop Tomcat server
Right click on your projec® File > Import-> Import ...

Select Generab Archive File

& Import x|

Select
Import resources from an archive file into an existing project. I_E < 5 I

Select an import source:
|type filter text

E-= General

R} Achive File |
o Breakpuoints
¥ Existing Projects into Workspace

----- (7, File System

------ E Preferences
- CVS

F-= EIB

- 12EE

#-[= Plug-in Development
F-= Team

= Web

- Web services

(7 = Back I Mext = I Firish Cancel

Select « Next » button
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Browse to select the filelosys-x.x.x-StarterKit.zip ...

Archive file [ EY

=4

Import the contents of an archive file in zip or tar Format From the local File system.

From archive file: ||:I:'l,|:ur|:ufiles'l,l:l:lesm|:|ul'l,r'-“ly Documents| Téléchargementsitelosys-1, v| [ Browse. .. ]

B [v] = H =] telosys-toals.cfg
== sre
= TelosysTools
= webContent

[Filter I}.-'pes...] [ Select All ] [ Ceselect Al

Inko folder: |TelnsysTnDIsExampIe | [ Browse, ..

|:| Cverwribe existing resources withauk warning

':?:' Einish ] [ Cancel

Select « Finish » button
Overwriteweb.xml in folderxxx/WebContent/WEB-IN ? = Yes

That's all !
Your project is now a “Telosys project”.

Telosys Starter Kit Page 14



7 — Run the project

Right click on your projec® Run As—> Run on server

& Run On Server

X|
Define a New Server
Choose the type of server to create

How do you want to select the server?
%' Choose an existing server
" Manually define a new server

Select the server that you want to use:
E = localhost

E Tomcat v3.0 Server @ localhost

View By: IHnst name vl

Description: Apache Tomcat v5.0 supports J2EE 1.2, 1.3, and 1.4 Web modules.

™ Set server as project default (do not ask again)

(7] < Back MNext = | Finish I Cancel
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o [ .;éh |http:,l',l'|l:ll:a||‘|l:lst:EiDE‘D,I'TE|DS';.-‘STDD|5EXEII'I'||:I|E,I'

Telosys test page

Test servers presence

Test screenmap server without screen name

Test actions server without action name

Test services server with nonexistent service

Test servers with real resources

est screenmap server with an existing screen ( 'test’ )

Test services server with an existing RPC service ( 'ping' )

Check there’s no error in the console.

Problems| Tasks| Properties| Servers| Snippets m

“|GEl| B -5y =0

info
info
info
info
info
info
info
info
info
info
info
info
info

[org.
[env.
[env.
[env.

[env.

[enw

[env.

[enwv

[env.
[env.
[env.
[env.
[org.

objectweb.telosys.common.Telosys] INIT : Telosys.init (extFactory, config)

Tomcat v5.0 Server _ localhost [Apache Tomcat] D:\TelosysToulouse\java\bin\javaw.exe (Apr 3, 2007 8:40:49 PM)

[

objectweb.telosys.auth.AuthFilter] init({) : Login URL = null
InitServlet]

InitServlet] InitServlet : initc|{

InitServlet] Server Info : Apache Tomcat/5.0.28
InitServlet] === Version : 2.4

.InitServlet] = Context Hame : Application Name
InitServlet] Eeal Path : D:\TelosysToulousze\workspace' .metadata\.pluginshorg.ecl
.InitServlet] === Main Factory Creation ...

MainFactory] MainFactory creation ...

MainFactory] =screen registry creation ...

MainFactory] service registry creation ...

InitServlet] === Telosys Initialization ...

i

Stop Tomcat Server
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8 — Configure the project

Edit the Telosys project properties :
Select your project + right clic® “Properties™> Telosys

You can define here :
* The repository’s folder
* The templates folder
« The names of the Java packages
e The construction of the classes names
e etc...
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9 — Install the “Bookstore” DERBY database for test

DownloadbookstoreX.X_derby X.X.X.zip from the Telosys web site
http://telosys.ow2.org~> Download

Unzip the file in a folder ( this folder will bee¢rDERBY_HOME folder )

Start DERBY by running the command file
DERBY_HOME/start.bat
or
DERBY_HOME/bin/startNetworkServer.bat (Windows)
DERBY_HOME/bin/startNetworkServer (shell Unix/ILix)

The database engine is running in a command windoa js now ready to accept

connections.

To stop the Derby database : just close this window
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10 — Connect to DERBY database

Edit the ‘databases.dbcfyfile with a “text editor” and uncomment DERBY par

<db id = "0
name

url

g

izolationLevel

poolsize

<property namwe="user"™ wvalue="root" />
<property namwe="password” valus="admin" F>

= "DEREY - TelosysEBook3tore DE™
driver = "org.apache.derby. jdbe.ClientDriver™
= "jdbe:iderby:// localhost: 1527 /bookstore™

=

<metadata catalog="" schema="ROOT" tsble-name-pattern="%" tabhle-types="TAELE

_<fd.b>|

Save and closgatabases.dbcfdile an open it with theDbconfig editor”

- 0

Fim Project Explorer X

.
L]

I=F Servers
= H TelosysToolsExample
|z'] Deployment Descripk
= "ﬁ Java Resources: src
B env
B env.navig
=B, Libraries
B Apache Tomi
B EAR Libraries
B, IRE Twstem |
=, web App Liby
= build
[= TelosysTools
== WebContent
[= META-INF
[= screen
[= telosys
[ template
[= test
(= WEB-INF
== conf

database

o & B85

[ Paste
Delete
Build Path

Refactar

£2g Impart...
L7 Export...

& | Refresh

Walidate

Fun As
Debug As
Profile As
Team
Compare With
Replace With
Source

Properties

SR

- ._-—=| Dbconfig editar

VIEW M />

Chrl+C Text Editor
|=| System Editar
Chrl+Yy |=| In-Place Editor
Delete Default Editar
3
Alk+Shift+T ¥
F=
3
3
3
3
3
3
3
Alk+Enter

5.dbcrg
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Select database

£ databases.dbcfg X =0

Database A

0 - DEREY - Telo okStore DH [ Generate repository ] [ IUpdate repositary

Configuration |InFu:urmatiu:uns Meta-data

Id: [ Test connection

Mame :
Drriver org.apache.derby. jdbc. ClientDriver

Isolation lewvel :

Pool size 5

|
|
|
URL : | jdbec:derby: fflocalhost: 1527 bookstare
|
|
|

User ok

Passward | ‘ adrin

| £

Database

Select «Test connection» button to test connection to database
Select «Generate repository» button

Repository is generate FelosysTools/repoglirectory

== TelosysToaols
= lib
== repos
@I DEREY - TelosysBookStore DE.dbrep
infio, bk

To allow the dynamic association between the engtyie and its Value Object bean
and its DAO editWebContent/WEB-INF/conf/telosys.propertiesand uncomment
these two properties “daoclass” and “recordclass” :

# DALD mlass name pattern for dynamic DAD registry/regist

daoclass = wvo.dao. §{BELNNLME DAD

# daoclass = wvo.dao.dbi{DEID}.3{BEANIANE} DAD

# Walue Chiject Eean class name pattern to determine the
# [ WE : can be overridden in 'datahases.dbofg' )
recordolass=vo. §{EELNINALME}

Be sure that the classes names are conform toctips& project properties ( packages
and classes names )
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Double click on the repository file to edit databaables

& DB.dbrep X

Database "DERBY - TelosysBookStore DB" ( Apache Derby )

Database table

[AUTHOR v|

Mapping and standard classes | Specific

Database Name Database Type JDBC Type Java Mame Java Type
W D ¥ INTEGER 4 i inkeger id ink
FIRST_MAME WARCHAR(40) 12 : warchar firsthame Skring
LAST_MAME WARCHAR(40) 12 : warchar lastMarne Skring

|~

Java classes

Value Object Bean (WO )
| Author |

Bean list { YO List )
| futharList |

Bean D.A.0.
| futharDA0 |

Bean converter (ML)
| Authoriml |

[ Generate ]

tMapping | Bulk generation | Config

Generate tables one by one :

You can generate files for a table by selectingerésate » button.
These files are create in packages definéslasys-tools.cfdile (if packages definition

are modify in this file, you have to regenerateosa{ory)
Select « Config » tab to see defined packages.

Generate all the tables :
Select «Bulk generation » tab

Telosys Starter Kit

Page 21



Bl DEREY - Telosy

kStore DB.dbrep X

Database "DERBY - TelosysBookStore DB" ( Apache Derby )

Table Mame Java Bean
AUTHOR Author
BOCK Eook
EOOK_ORDER, Eookorder
BOOK_ORDER_ITEM BookCrderItem
COUMTRY Country
CLSTOMER Customer
EMPLOVYEE Employee
PLIBLISHER, Publisher
REVIEW Review
SHOP Shop
SYMOPSIS Synopsis

<

Standard targets
‘alue Object Bean { WO )
Eean list { W0 List )
Bean D.4.0.
Bean converter (XML

Specific targets

[ Select all

] l Deselect Al

[ Select Al

] [ Deselact Al

[ Launch bulk generation ]

Select « Select All » buttons
Select « Launch bulk generation» button

The project “Data Access Layer” is now ready to.use
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11 — Test the project “Data Access Layer” with the
database

Right click on your projec® Run As—> Run on server

By default each DAO can be called in REST mode énaJRL) :

How to call a DAO in REST mode (request examples)

dao/Authorloadlist
dao/ Authorloadlist Twhere=id < 3
dao/Authorload?id=1

Select one of the links to see the results
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